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Interested in undergraduate research at UC Berkeley?
Please visit http://research.berkeley.edu
We have several residential summer research programs (SUPERB, 
SROP, Biological Sciences, Amgen, etc.) that would like you to apply. 

Want to learn more about the nation-wide alliances of 
NSF AMP diversity science programs for Undergraduates?
Please visit www.camp.uci.edu
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Large Format Posters
General Format Guidelines

Posters should be readable from at least three feet 
away. Everything on your poster should be computer 
generated for a professional look. 

Headings no smaller than 34 point type. 
Text no smaller than 24 point type. 

Usually poster files are created in MS PowerPoint. 
AVOID large extensive, deep color backgrounds.
Dimensions should be 36” H x 48” W (landscape).
FYI: posters can take anywhere from 1 to 10 hours  
to print (based on the size and images). Make sure 
to plan accordingly and always bring a copy of your 
poster with you on a flash drive or cd-rom (just in 
case).

Need Help or Have Questions
General questions about research posters?                  
Contact Diana Lizarraga at #510/643-8978 or 
ladiana@berkeley.edu or 
diana_lizarraga@hotmail.com

Please note that many of the items in these  
handouts can be done in a variety of ways                    
and I just highlight a few of them.
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Changing Your Poster Size
This poster are typically set at 48 inches wide by 
36 inches tall. If you want to change the size of 
your poster follow the steps below.

Step 1: from the file menu go to page set up.

Step 2: change the settings for your width and 
height to your preference (make sure you have 
the right slide orientation, which is typically 
“landscape”), then select  the “ok” button.

STEP #1 STEP #2
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Basic PowerPoint Tips
Make sure that you know what version of PowerPoint you are working with. 

Save your files frequently and save a back up copy.

Add a Text Box
1. From the bottom of the 
screen select the text box icon 
(looks like a small newspaper 
with the letter A on it)
2. Drag your mouse to create 
your new text box in the desired 
location. 
Note: you can move the text 
box by dragging it with your 
mouse or by clicking on it and  
using your arrow keys

Create a Presentation
1. Open PowerPoint 
2. Select file menu, then new
3. Choose presentation design 
that you like (a variety of 
options should appear from 
“blank” to “from design 
template” to “from AutoContent 
Wizard”)
4. Next, pick a slide layout and 
then start typing

Changing Templates
1. Go the format menu
2. Pick slide design
3. Explore the options and then 
choose the desired template
4. Click on desired option (or 
select “apply” if there is a 
button) to activate

Slide Color Schemes                   
(fills, accents, and text)

1. Go the format menu
2. Pick slide design and look at 
the upper right hand corner of  
the screen for the “color 
schemes” hyperlink (click on it)
3. Pick a standard scheme or 
customized your colors (click on 
edit color scheme-bottom right) 
and then select apply

Layering (ex: layer text boxes 
over rounded boxes)

1. Click on the object that you 
want to layer
2. Select the draw menu (lower-
left of the screen) 
3. Select the order option
4. Pick the desired option (bring 
forward, send backward, bring 
to front, send to back)

Changing Backgrounds
1. Go to the format menu
2. Pick background
3. Select desired fill color from 
the drop-down menu
4. Select apply (to current slide) 
or apply to all (all slides)

Changing Bullets                      
(fyi--bullets can be omitted)

1. Click on the designated text 
line
2. Go to the format menu
3. Select bullets and numbering
4. Select the customize button 
5. Pick bullet style, size, and 
color (or omit it) that you like
6. Select ok

Creating Boxes with Rounded 
Corners

1. From the bottom of the 
screen select the AutoShapes 
menu
2. Pick basic shapes
3. Select the box with rounded 
corners (first object in 2nd row)
4. Drag your mouse to create 
your new rounded box

How to Save a File
1. Go to the file menu
2. Select save (a pop-up box 
should appear) 
3. From this pop-up box click 
save or you can also look at the 
“save as type” (bottom drop-
down menu) option and select 
the desired version
4. Select ok
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How to Make a Flow Chart

Step #1:  Making Shapes and Color Fills
1. Go to the slide where you want to make your flow chart.
2. Make sure your drawing tools are activated and visible (bottom of the screen). If not 

then activate it from the “tools” menu (pick “customize” and then select the “toolbar” 
tab).

3. Click on the desired shape (for example a square).
4. Move your cursor onto your slide and click and drag to the desired size.
5. Move your new shape to the desired location by selecting it (so that the white box 

around the edge of the shape is showing) and then move it.
6. To fill this shape with a color (or fill gradient, texture, pattern, or picture) simply 

select it and then go to the fill bucket (located at the bottom of your screen..it looks 
like a little paint bucket) or you can use the color and lines options from the “Format 
Menu.”

7. Select desired fill and then apply it.

Note: You can manipulate these shapes by selecting the shape and then going to the 
“Draw Menu” and then “Change Autoshape.”  Here you have a wide selection.  
Once you find a shape you like then you can double-click on it an it will convert your 
original shape into a new shape.

Step #2:  Adding a Text Box 
1. To add a “Text Box”  go to the bottom of the screen and choose the icon that looks 

like a little newspaper with an A on it (or go to the “Insert Menu and choose Text 
Box).

2. Move your cursor onto the slide and click on the desired location.
3. Immediately start typing (or you will loose your text box).
4. You can manipulate the text size , text color, and text box fill, and text box outline if 

you want by using the drawing tools (bottom of screen) or by using the “Font” and/or 
“Color and Lines” options from the “Format” menu.

Step #3: Grouping Two Objects Into One Object (optional step)
1. Select first object (example: a square shape). Then hold down the shift key and 

select the second object (example a text box).
2. Let go of the shift key and go to the “Draw Menu” (lower-left corner of screen) and 

select “Group”.  Now the square and the text box will move together as one object.  
There is no limit to how many objects you can group.

3. To ungroup objects select the object and then go to the “Draw” menu and choose 
the “Ungroup” option.  Then click away from the objects (ex: in the gray space on 
the sides of the slide) and they will be separated.

create a shape

Create a 
text box

group 
both 

objects

2 objects 
are now 
1 object
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How to Import an Excel Graph
Fig. 3  Average Allele Frequency For Three Specific Alleles In The Little Kern 
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Importing an Excel Graph Into PowerPoint
1. Go to the slide where you want to place                         

your graph.
2. Then minimize PowerPoint and                                    

open Excel.
3. Open desired Excel graph.
4. Locate the graph and click on it so that it is selected.
5. Go the Excel “Edit” menu and choose copy.
6. Minimize Excel and Maximize PowerPoint.
7. Click on the desired slide where the graph will go.
8. Now, go to PowerPoint’s “Edit Menu” and select “Paste”.
9. You may need to resize your graph to completely cover the slide area.

Importing a Word Table Into PowerPoint 
1. Go to the slide where you will                                  

place the table.
2. Then minimize PowerPoint and open Word.
3. Open desired Word file with the table.
4. Locate table and highlight the cells that you                   

want to copy.
5. Go the Word “Edit” menu and choose copy.
6. Minimize Word and Maximize PowerPoint.
7. Click on the desired slide where the table will go.
8. Now, go to PowerPoint’s “Edit” menu and select “Paste”.
9. You may need to resize your graph so that you text is legible.

Note: If you can not read the table because the slide background is too 
dark then you may need to select the table and fill the background color 
of the table to white (or a lighter color) so that it is easier to read.

How to Import a Word Table
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Borrowing Web Images
Note: If appropriate, you should give credit for borrowed images.

Step #1:  Acquiring a Web Image
1. Locate the desired image on the web.
2. Put your cursor directly on top of the                          

image and click with your right mouse button.
3. From the options, click and “save image as”.
4. Rename the image and save it as a jpeg or gif file (you will 

need to know where you saved it to so don’t forget).
5. Write down the web address and date so that you can give 

appropriate credit (if applicable) in your acknowledgement 
section or just below the image.

6. Note: many images are copyrighted so please document all 
sources of borrowed images and talk with your mentor).

Step #2:  Importing Web Images
1. Go to the slide where you want to place the image.
2. Go to the “Insert Menu” and select “Picture”, then choose 

“From File”.
3. Locate your web image that you saved previously and click 

on insert.

FYI: You can also import images as an Object…use the 
help menu to walk you through the process.

This image 
was taken 
from the 
SACNAS 
web site.
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Poster Organization
Headings 
(Note: your mentor needs to approve your content.)

Title and Author. Include your name and school, 
as well as your faculty mentor’s name, 
department, and school with zip code.  The title 
should be at no smaller than 55 point type.
Abstract.  This should include a statement of the 
research question/s or problem/s. Typically 
around 175-250 words.
Introduction/Background. Significance of 
project to society.
Methods. Describe the steps you used for your 
project.
Results/Data Analysis. More space should be 
devoted to your results than to any other section.  
This is where you should use graphics, images 
and tables.  It should have prominent placement 
in the center of your poster. Describe what you 
found.
Discussion/Conclusion.  What can you 
conclude from your research? What are the
implications and the importance of your findings? 
How does this compare to what others have 
found?
Next Steps. Briefly describe what will happen 
next for your project.
References (optional). Major sources on which 
your research project relied. 
Acknowledgments. People who helped you with 
your research and/or poster.
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Stylistic Considerations
Things to Think About

Design your poster based on your audience 
(faculty, high school students, etc.)  
Sketch out a rough draft of what you hope the 
poster will look like.
Component parts should be organized vertical or 
horizontal, but not both.
Leave some open space in the design.
Convert tabular material to graphic display if 
possible.
A large and/or bright center of interest can draw 
the eye to the most important aspect of the 
poster.  Use color to add emphasis, clarity, and 
attractiveness.
Use photographs, charts, and other visuals to 
enhance your display.  Enlarge photos to show 
pertinent details clearly.  

Scan images at high resolution (150 or above).
Consider using a succinct headings (8 words or 
less, or what will fill a single line). These should 
be consistently styled, whether in all caps or initial 
caps, boldfaced or underlined, flush left or 
centered. Be consistent throughout the poster.
Avoid thick blocks of unbroken prose (long 
paragraphs)…use lists and bullets.
Strive for a balance between texts and graphics.   
Balance is affected by the size, shape, and color.
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A Judge’s Viewpoint

Key Items!

• What did you do?

• Why did you do this? Why is 
it important to solve this 
problem?

• How did you do it? How did 
you solve this problem or 
contribute to the solution of 
this problem?

• What’s the next step?

• What are the implications of 
this project?

• Could you explain your 
project with confidence?

• Did you understand your 
research question?

• Did you understand why you 
used particular statistics or 
analytical methods?

• Could you contextualize 
your project for your 
audience?

Was your poster 
presentation 
appropriate and 
professional?

• Did your poster make 
sense? 

• Use of visuals

• Explanations based 
on target audience

• Titles, references, etc. 

• Did you speak too fast 
or too softly?

• Were you well 
groomed and in 
professional attire?
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Poster Competitions
Seven Ways to Blow It!

Don’t practice your 
presentation

Don’t label your 
figures

Have an incomplete 
title

Don’t use references

Don’t spell check 
your content

Use inappropriate 
images 

Use all small text 
and few images

Your goal is to 
explain the 
following:

The “What and     
the How”

The “Why”

The “What Next”

Know your statistics

Know your research 
question or hypothesis

Know the big picture

Know your lab and 
lab members

Know your project’s 
implication and/or 
relevance

If possible see as many poster designs as possible so that If possible see as many poster designs as possible so that 
you can design the poster of your dreams.you can design the poster of your dreams.
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Recap of Basics
Cost

Typical Size 4 ft wide x   
3 feet tall
Kinkos: $100-200  
(coated paper)
Sometimes fees are in 
linear feet

Time to print
one to ten hours 
Depends on the graphics, 
poster colors, and 
resolution of the images

First Steps
Collect your content 
(make sure to have your 
mentor’s approval)
Obtain your images
Decide if you want to go 
vertical or horizontal with 
your information
What colors are 
appropriate for your 
poster?
What size should your 
poster be?

Large Format Plotter 
Printer

• Use coated paper if 
you are going to 
laminate your poster

• Lamination costs with 
grommets is about $40

• Use photo glossy if 
you are not going to 
laminate your poster or 
if you have great 
images (glossy is more 
expensive)
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Final Thoughts
General Questions People Will Ask You

Can you run me through your poster?
How did you get interested in this project?
Where the findings what you expected?
What was the most difficult aspect of this project?
What have other people in your field found?

Gentle Reminders
Find out if you need to bring tacks/t-pins or if they 
will be provided for you.
Find out the location of your poster presentation 
ahead of time.
Dress appropriately and professionally for the 
occasion but remember to wear comfortable 
shoes (as you will be on your feet for a long time). 
Bring a bottle of water with you.
Bring business cards (free cards at 
www.vistaprint.com)
Consider having about 5-10 copies of your 
abstract available, if requested.  Be sure to 
include your name, address, phone number,             
and email.  
Remember to relax and smile!
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